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1 Введение
Умение обрабатывать данные становится обязательным элементом культуры со-
временного человека. Этому способствуют всеобщая компьютеризация, рост обра-
зованности населения, практика учёта и финансового анализа и др. Не последнюю
роль играет быстрое распространения цифровых фото- и видео-данных, позволя-
ющих редактировать изображения. Естественно, что наибольшие потребности и
возможности для работы с данными существуют в науке. Создано большое ко-
личество программ, облегчающих получение информации из первичных данных,
для чего используются их визуализация и математическая обработка. Некоторые
из этих программ узко специализированы, другие, такие как Origin, носят более
универсальный характер. Разнообразие сочетается с общностью многих базовых
элементов, обусловленной единством используемых математических методов об-
работки и ставших стандартными требованиями к возможностям и интерфейсу
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программ. Освоение пользователем конкретной программы сопровождается усво-
ением и общих принципов обработки данных, что позволяет при необходимости со
сравнительно меньшими усилиями научиться работе с другими типами данных и
программами их анализа.

Целью Общего ядерного практикума физического факультета МГУ является
знакомство студентов с разными типами радиоактивности, искусственной радио-
активностью, делением ядер, взаимодействием частиц с веществом, свойствами
элементарных частицам и др. Физическое разнообразие представленных задач со-
провождается относительным единством в методах обработки получаемых экспе-
риментальных данных.

Данное руководство не является учебным пособием по Origin. Его задача со-
стоит в

• указании последовательности действий, с помощью которых можно правиль-
но обработать данные;

• приведении примеров оформления результатов.

2 Обработка данных в задаче № 6 "Определе-
ние эффективного сечения взаимодействия γ-квантов
с веществом методом поглощения"

1. Создайте проект. В столбец A(X) окна данных Data1 введите данные о тол-
щине поглотителя, в столбец B(Y ) — соответствующие значения интенсивно-
сти потока γ-квантов.

2. Выделите столбец B(Y ), щёлкнув на B(Y ) правой кнопкой. Командой Column →
Set Column V alues откройте окно, позволяющее изменять данные. Сотрите
информацию в нижнем поле. В выпадающем списке данных выберите col(B).
Вычтите фон: col(B)− фон и нажмите OK.

3. Командой Column → Add New Columns добавьте новый столбец C(Y ). Вы-
делите новый столбец и преобразуйте его в столбец данных статистических
ошибок ln(col(B)) с помощью команды Column → Set Column V alues. В
списке доступных функций преобразования данных, выберите sqrt() и на-
жмите Add Function, в списке данных выберите col(B) и нажмите Add Column.
Переместите курсор в начало формулы, добавьте 1/, чтобы получилось 1/sqrt(col(B)),
и нажмите OK.

4. Снова выделите столбец C(Y ) и командой Column → Set as Y Error пометь-
те его как Y Error.

5. Выделите столбец B(Y ), щёлкнув на B(Y ) правой кнопкой. Преобразуйте
интенсивность в её логарифм командой Column → Set Column V alues. В
появившемся окне Set Column V alues сотрите информацию в нижнем поле.
Нажав на стрелку, откройте выпадающий список доступных функций преоб-
разования данных, выберите ln() и нажмите Add Function. В выпадающем
списке данных выберите col(B) и нажмите Add Column. В нижнем поле по-
явится закон преобразования данных столбца B(Y ) — ln(col(B)). Нажмите
OK и данные столбца B(Y ) в окне данных Data1 преобразуются в их лога-
рифмы.
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Теперь постройте график зависимости интенсивности γ-квантов от толщины
поглотителя в полулогарифмическом масштабе. Способ построения описан в раз-
деле "Обработка данных в задаче № 2. Построение градуировочной кривой". Вы-
берите все данные окна Data1 и командой Plot → Scatter постройте график из
экспериментальных точек.

Проведите через эти точки прямую командой Analysis → Fit Linear. В окне
Results Log в нижней части экрана (окно можно вызвать командой V iew →
Results Log) показаны параметры прямой, включая тангенс угла наклона B и
его ошибку. B есть линейный коэффициент поглощения τ (см. описание задачи
№ 6), зная который можно найти эффективное сечение ослабления σ γ-излучения
и далее энергию γ-квантов.

3 Обработка данных в задаче № 2 "Радиоак-
тивность, альфа-распад, взаимодействие альфа-
частиц с веществом"

3.1 Построение градуировочной кривой
1. Добавление столбцов. Первоначально, при создании нового проекта, поля

листа данных (Worksheet) содержат два столбца: A(X) и B(Y ), описываю-
щих зависимость X от Y . Дополнительные столбцы добавляются командой
Column → Add New Columns.
Добавьте ещё пять столбцов, появится таблица, содержащая семь столбцов с
именами A(X), B(Y ), C(Y ), D(Y ), E(Y ), F (Y ), G(Y ).

2. Разметка столбцов и внесение данных.

(a) Внесите в столбец A(X) данные о номерах каналов, соответствующих
максимумам пиков от известных источников.

(b) Внесите в столбец B(Y ) данные об ошибках определения пиков (полуши-
рины пиков на амплитудных спектрах). Обозначьте командой Column →
Set as X Error столбец, как X Error, его заголовок изменится на B(xEr±).

(c) Внесите в столбец C(Y ) данные об энергиях, соответствующих пикам.
(d) Обозначьте командой Column → Set as X столбцы D(Y ) и F (Y ) как X.

Названия столбцов изменяться на D(X2), E(Y 2), F (X3), G(Y 3).
(e) Командой Column → Set Column V alues внесите в столбцы D(X2) и

E(X2) значения col(A) + col(B) и col(A) − col(B) соответственно, а в
столбцы E(Y 2) и G(Y 3) — значения col(C). Последнее можно также сде-
лать копированием и вставкой данных столбца C(Y ).

3. Выбор данных. Для построение графика необходимо выбрать соответству-
ющие данные. Для выбора всех данных поместите курсор в правый ниж-
ний угол белого прямоугольника, расположенного вверху слева над номерами
строк (курсор приобретет вид стрелки, направленной вниз вправо), и щёлк-
ните левой кнопкой. Для отмены выбора щёлкните в верхнем левом углу
прямоугольника. Можно также щёлкнуть на названии последнего выбирае-
мого столбца при нажатой клавише Shift или отметить нужные данные при
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Рис. 1: Зависимость между номерами каналов и энергией для известных источников.
Экспериментальные точки с ошибками, равными полуширинам пиков амплитудного
спектра*.

нажатой левой кнопке. Выбор отдельных столбцов возможен при нажатой
клавише Control.

4. Построение графика. Выберите столбцы A(X), B(xEr±), C(Y ). При
выбранных данных график строится командой Plot → PlotStyle. Постройте
график экспериментальных точек с ошибками (рис. 1) с помощью команды
Plot → Scatter, которая также доступна из контекстного меню, вызываемого
правым щелчком на выбранном листе данных .

5. Построение области интерполяции.
Добавление второго слоя графика.Добавьте в построенный график второй
слой командой T ools → Layer. В окне Layer выберите символ графика с
вертикальной левой и горизонтальной нижней осями и закройте окно. На графике
вверху слева появится второй значёк слоя с цифрой 2. Значёк активного слоя
имеет чёрный номер, неактивного — белый.
Синхронизация осей слоёв. Щёлкните на значке слоя 2 правой кнопкой и
выберите Layer Properties. В открывшемся окне щёлкните слева на Layer2 и
потом справа на Link Axes Scales. Выберите Link to Layer1. В открывшихся
опциях X Axis Link и Y Axis Link выберите Straight (1 to 1) и закройте
окно.
Выбор данных и построение графика. Снова выберите слой 2, щёлкните
на графике правой кнопкой и выберите Layer Contents. В появившемся окне
Layer2 в Available Data выберите data1_e и с помощью⇒ скопируйте данные
в Layer Contents. Аналогично поступите с данными data1_g и нажмите
OK. На графике появятся границы области интерполяции, внутри которой с

4
* Олег Иванович как “махровый” теоретик, специалист по многомерным черным дырам и 
гафниевым бомбам, в этом месте, как нормальный человек, ошибается. Разрешение 
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заданной (выбором величин ошибок) вероятностью проходит градуировочная
кривая (рис. 2). Области экстраполяции при необходимости можно построить
с помощью инструмента Line Tool из ToolBar.

6. Параметры графика можно менять в окне Plot Detail, вызываемом коман-
дой Format → Plot, не закрывая окна (Apply). Окно Plot Detail можно
также вызвать из контекстного меню, открываемого правым щелчком в об-
ласти графика.

7. Оформление осей вызывается командами вида Format → Axes → XAxis
или из контекстного меню, вызываемого правым щелчком на оси (Axis) или
её названии (Properties). В окне Axis оси выбираются щелчком на них в
разделе Selection.
Проверьте номера каналов, соответствующих пикам от неизвестных источни-
ков на их амплитудных спектрах. Если они выходят за пределы, показанные
на построенном графике, увеличьте диапазон значений на осях (Axis : Scale :
From...To). Внимание! Изменение масштабов на осях после проведения по-
строения приведет к перемещению экспериментальных точек, в то время как
остальные элементы графика останутся на своих местах.

8. Построения для определения энергий неизвестных источников. От-
метьте на границах области ошибок градуировочной кривой диапазон номе-
ров каналов (границы полуширин) для пиков неизвестных источников. Для
этого выберите инструмент Draw data из ToolBar, нажав на кнопку с изоб-
ражением точек, указатель мыши приобретёт крестообразный вид. Нажмите
левую кнопку мыши, появится окно с информацией о координатах указателя.
Переместите указатель в нужную позицию и нажмите Enter, позиция будет
отмечена точкой.
Через отмеченные точки проведите вертикальные и горизонтальные линии до
пересечения с координатными осями. Для этого в окне Plot Detail в списке
элементов соответствующего слоя выберите данные DrawN : A(X), B(Y ), по-
сле чего слева выберите Drop Lines и отметьте пункты Horisontal и V ertical,
далее выберите Style Dash и нажмите Apply. Для устранения символа точки
выберите пункт Symbol и опцию Size 0.

9. Используйте инструмент Screen Reader из ToolBar для определения энергий
с ошибками, соответствующих α-частицам неизвестных источников (рис. 3).
График не должен содержать неиспользуемых участков градуировочной кри-
вой, иначе рабочий участок будет слишком мелким. На рис. 3 правая область
экстраполяции не используется и не показана.

10. Дополнительные текст, линии, стрелки и т.п. добавляются с использовани-
ем инструментов из ToolBar. Знак ± в режиме текстового набора вводится
командой \(177). Оформите кириллическим шрифтом заголовок и названия
осей (Format → Axis T itles → X Axis T itle). Частота меток на осях регу-
лируется командой (Format → Axis T ics Label : Scale : Major(Minor) Tics)
(рис. 3).
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Рис. 2: Область, в пределах которой с вероятностью, заданной ошибками, может прохо-
дить градуировочная кривая. Стрелками указаны область интерполяции, расположенная
между экспериментальными точками, в которой точность определения энергии по номе-
ру канала максимальна, и области экстраполяции, расположенные вне опорных точек,
в которых точность быстро уменьшается по мере удаления от последних. Для включе-
ния в график областей экстраполяции диапазон значений, отображаемый на осях, был
увеличен.
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Рис. 3: Определение энергий α-частиц неизвестных источников.
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3.2 Обработка данных измерений пробега α-частиц в
воздухе

1. Создайте новый проект с листом данных, состоящим из трёх столбцов: A(X)
— расстояние между источником и детектором; B(Y ) — интенсивность потока
α-частиц; C(yEr±) — ошибка интенсивности.

2. Выделите все данные и постройте (Plot → Scatter) график эксперименталь-
ных точек (рис. 4).
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Рис. 4: Зависимость интенсивности потока α-частиц I от расстояния между источником и
детектором x. Данные эксперимента.

3. Продифференцируйте (Analysis → Calculus → Differentiate) график экс-
периментальных точек (рис. 5).

4. Откройте окно проекта(V iew → Project Explorer). Оно появится внизу экра-
на и в нём показаны параметры окон всех составляющих проекта — их име-
на, типы, представления и др. Любое из окон составляющих проекта можно
скрыть. Для этого в окне проекта правым щелчком на значке окна состав-
ляющего откройте контекстное меню и выберите Hide Window. Окна можно
восстанавливать — Show Window и стирать — Delete Window.
Скройте окно данных пробега Data1.

5. График DerivPlot1 имеет неудовлетворительный вид, преобразуем его, из-
менив знак координаты Y и стиль. Сотрите DerivPlot1. В окне проекта от-
кройте лист данных дифференцирования Derivative1. Правым щелчком на
заголовке столбца Data1B(Y ) [Derivative of Data1_B] откройте контекстное
меню и щёлкните на Set ColumnV alues. В выпадающем меню Add Column
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Рис. 5: Результат дифференцирования графика экспериментальных точек пробега α-частиц.

выберите Col(Data1B) и нажмите на Add Column. В белом поле ввода по-
явится Col(Data1B), поставьте перед ним знак минус и нажмите OK. В ре-
зультате все данные столбца Data1B(Y ) [Derivative of Data1_B] изменят
знак.
Выделите все данные листа Derivative1 — Derivative of Data1_B и по-
стройте новый график результатов дифференцирования экспериментальных
точек (Plot → Scatter). На этот раз он имеет нужный вид (рис. 6).

6. Теперь объединим два построенных графика, разместив их в разных слоях
(Layers) одного графика.
Скройте Derivative1 и Graph2. Вернитесь к графику пробежной кривой
Graph1 (рис. 4). В верхнем левом углу белого поля виден значок с цифрой
1, обозначающей номер единственного слоя графика. Добавьте второй слой
(Tools → Layer). В появившемся окне Layer нажмите значок с выделенной
правой вертикальной осью и закройте окно. На графике появятся справа ось
Y и слева вверху значок с цифрой 2, соответствующий новому слою.

7. Новый слой пока пуст, заполним его. Двойным щелчком на значке "2" от-
кройте окно Layer2. В разделе Available Data выберите derivative1data1b —
данные результатов дифференцирования, нажав ⇒, скопируйте их в раздел
Layer Contents и нажмите OK. Результаты дифференцирования появятся на
графике (рис. 7) .

8. Проведём через экспериментальные точки кривые (рис. 8). Размещение дан-
ных в разных слоях позволяет обрабатывать их по отдельности.
Выделите слой данных пробега, щёлкнув на значке "1 и постройте пробежную
кривую (Analysis → Fit Sigmodial). Выделите слой данных дифференциро-
вания "2" и постройте кривую Гаусса (Analysis → Fit Gaussian). Кривую
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Рис. 6: Результат дифференцирования графика экспериментальных точек пробега α-частиц
после изменения знака данных dI/dx.

можно сделать более гладкой (Analysis → Smoothing → . . . ).
В общем случае аппроксимационная кривая строится следующим способом.

• Сотрите в окне проекта построенную кривую Гаусса.
• Откройте (Analysis → Non− linear Curve F it) окно диалога
Non-linear Curve Fitting: Fitting Session.

• Выбор аппроксимирующей функции. Выберите Function → Select и в
окне Non-linear Curve Fitting: Select Function в разделе Category
выберите Origin Basic Functions и в разделе Function — Gauss. В ниж-
нем разделе Area version of Gaussian Function, переключаясь между
Equation и Sample Curve, изучите свободные параметры, входящие в
функцию аппроксимации.

• Установка связи между переменными и данными. Выберите Action →
Dataset. В окне Non-linear Curve Fitting: Select Dataset в разделе
V ariables выберите y, а в разделе Available Datasets — данные derivative_1data1b,
нажмите Assign. В разделе V ariables будет показана связь, установлен-
ная между переменными и данными.

• Графический вид аппроксимирующей функции. Выберите Action → Simulate.
В окне #Points введите 1000, чтобы график функции был гладким.

• Задание начальных значений параметров функции. Выберите Action →
Fit. В окне Non-linear Curve Fitting: Fitting Session в столбце V alue
присвойте параметрам функции Гаусса начальные значения, которые мож-
но примерно определить из построенного графика производной, и разре-
шите их менять, поставив метки в столбце V ary.

• Итерационная процедура построения функции. Нажимайте 1 Iter. и на-
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Рис. 7: График, объединяющий данные пробега и результат их дифференцирования.

блюдайте, как будут последовательно уточняться значения параметров в
столбце V alue и меняться форма кривой на графике Graph1. Когда из-
менения станут незаметны, нажмите Done, данные дифференцирования
будут аппроксимированы Гауссовой кривой (рис. 8).

9. Правым щелчком в свободной области графика откройте контекстное меню
и выберитеPlot Detail, откроется окно Plot Detail. В его левой части рас-
кройте структуры слоёв. Отдельные элементы слоёв можно стирать (правый
щелчок, Delete, Apply). Выбирая данные, можно менять их параметры (цвет
и форму) и, нажимая Apply, наблюдать результаты изменений, не закрывая
окна Plot Detail.

10. Высоту графиков в слоях можно менять, масштабируя их оси Y (Format →
Axes → Y Axis : Scale : From...To). Сделайте графики равными по высоте,
чтобы с помощью одной горизонтальной линии на полувысоте определить ве-
личину пробега Rα (расстояние, на котором поглощается половина частиц)
и его ошибку ∆Rα (полуширина дифференциальной кривой). Проведите ли-
нии, обозначьте оси, создайте заголовок и график приобретёт законченный
вид (рис. 9).
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Data: Derivative1_Data1B
Model: Gauss 
Equation: y=y0 + (A/(w*sqrt(PI/2)))*exp(-2*((x-xc)/w)^2) 
Weighting:
y No weighting
  
Chi^2/DoF = 0.00006
R^2 =  0.99895
  
y0 -0.00362 ±0.00365
xc 8.24809 ±0.00905
w 1.37893 ±0.02161
A 0.9336 ±0.01653

Рис. 8: Аппроксимация данных пробега и дифференцирования
.

4 Обработка данных в задаче № 7 и № 1 5   
"Деление ядер"
Построение градуировочной кривой описано выше в разделе 3.1 на с. 3. Рассмотрим
обработку данных спектра деления урана-235 тепловыми нейтронами (спонтанного 
деления Cf-252), определение положения пиков и их полуширин.

1. Ввод данных. Создайте новый проект. Импортируйте (F ile→ Import→ Single
ASCII) данные амплитудного спектра осколков деления урана (калифорния).
В столбце A(X) должны разместиться номера каналов, в столбце B(Y ) —число
частиц.

2. Ошибки числа частиц. В лист данных добавьте (Column → Add New Columns)
третий столбец C(Y ). Скопируйте данные столбца B(Y ) в столбец C(Y ).
Преобразуем данные столбца C(Y ) в информацию о статистической
среднеквадратичной ошибке числа частиц N, равной

√
N. Выделите столбец

C(Y ) и откройте (Column→ Set Column V alues) окно Set Column Values. В
выпадающем меню Add Column выберите Col(C) и нажмите на Add Column.
В белом поле ввода появится Col(C), преобразуйте его в sqrt(Col(C)) и нажмите
OK. В результате все данные столбца C(Y ) преобразуются в данные ошибок.

3. Выделите столбец A(X) и обозначьте его (Column → Set as X), как данные
X. Аналогично обозначьте B(Y ), как Y , и C(Y ), как Y Error.

4. Выделите весь лист данных и постройте (Plot → Scatter) график
амплитудного спектра (рис. 10).
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Рис. 9: Окончательный вид графика, включающего пробежную кривую, результат её
дифференцирования и построения для определения пробега и его ошибки.
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Рис. 10: Амплитудные спектры осколков деления урана-235 тепловыми нейтронами и
альфа-частиц, испускаемых ураном-234. Экспериментальные точки.
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Рис. 11: Амплитудный спектр осколков деления урана-235 тепловыми нейтронами. Экс-
периментальные точки.

5. Спектр альфа-частиц сейчас не нужен, а его показ делает вид спектра оскол-
ков малоинформативным. Командой Format → Axis → X Axis : Scale :
From...To : Apply установите диапазон значений на оси X, исключающий
спектр альфа-частиц. Не закрывая окна, в разделе Selection выберите V ertical
и отрегулируйте масштаб по оси Y (рис. 11).

6. Символы на графике 11 сливаются, уменьшим их размеры. Правым щелч-
ком в свободной области графика откройте контекстное меню и выберите
Plot Detail, откроется окно Plot Detail. В его левой части раскройте струк-
туру единственного слоя Layer 1. Выбирая его данные, можно менять их
параметры (цвет и форму) и, нажимая Apply, наблюдать результаты изме-
нений, не закрывая окна Plot Detail. Выберите данные точек и уменьшите
их размер. Выберите данные ошибок и установите Cap Width равным нулю.
График преобразится (рис. 12).

7. Построим кривую, аппроксимирующую спектр как сумму двух распределе-
ний Гаусса. Это делается командой Analysis → Fit Multi−peaks → Gaussian.
В окне Number of Peaks поставьте 2, в окне Initial half width estimate —
примерную полуширину. Двойными щёлчками ставшим крестообразным ука-
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Рис. 12: Амплитудный спектр осколков деления урана-235 тепловыми нейтронами. Экс-
периментальные точки.
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зателем отметьте максимумы пиков. На графике появятся (рис. 13) кривые
аппроксимации, их параметры и огибающая спектра.

8. Пики спектра можно обрабатывать и по отдельности. Для этого выберите
инструмент DataSelector из панели Tools. Поочерёдно захватите правый и
левый маркеры и установите их на границах диапазона данных пика. Разме-
ры маркеров можно менять, нажимая клавишу Space. Командой Analysis →
Fit Gaussian постройте кривую Гаусса, аппроксимирующую пик. Форму-
ла и параметры аппроксимации содержатся в окне Rezults Log (V iew →
Rezults Log), расположенном внизу экрана.

9. Оформите график (рис. 14) с использованием инструментов из ToolBar и
используйте его и данные аппроксимации для определения энергии осколков
деления с помощью градуировочной кривой (см. раздел 3.1 на с. 3).
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Model: Gauss 
Equation: y=y0 + (A/(w*sqrt(PI/2)))*exp(-2*((x-xc)/w)^2) 
Weighting:
y Instrumental
  
Chi^2/DoF = 453.27683
R^2 =  0.49671
  
y0 0 ±0
xc1 316.53881 ±0.2521
w1 195.58755 ±0.31985
A1 289247.88297 ±583.70808
xc2 597.19782 ±0.2281
w2 118.53019 ±0.28239
A2 144363.28608 ±440.60739
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Рис. 13: Амплитудный спектры осколков деления урана-235 тепловыми нейтронами.
Экспериментальные точки и аппроксимирующие кривые.
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Data: u235Fission_B
Model: Gauss 
Equation: y=y0 + (A/(w*sqrt(PI/2)))*exp(-2*((x-xc)/w)^2) 
Weighting:
y Instrumental
  
Chi^2/DoF = 453.27683
R^2 =  0.49671
  
y0 0 ±0
xc1 316.53878 ±0.2521
w1 195.58725 ±0.31985
A1 289247.78913 ±583.70796
xc2 597.1977 ±0.2281
w2 118.53005 ±0.28239
A2 144363.37076 ±440.60719
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Рис. 14: Пример оформления графика амплитудного спектра осколков деления урана-
235 тепловыми нейтронами. Величины ∆N1,2 = w1,2 характеризуют амплитудное распре-
деление осколков, связанное с возможностью деления урана разными способами; ∆n1,2 —
ошибку в определениях каналов, соответствующих наиболее вероятному способу деления
ядер урана.
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